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Introduction
Welcome to Order Management, a Business Portal for Microsoft Dynamics® GP 
application that provides trusted customers and company salespeople with the 
ability to enter sales orders using their web browsers. Once an order is placed, it is 
automatically transferred to Microsoft Dynamics GP for processing.

Check for updated instructions
This information was current as of March 16, 2010. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
documentation web site (http://go.microsoft.com/fwlink/?LinkId=185513) for the 
most current documentation.

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Additional resources
• Technical support
• Documentation feedback

What’s in this manual

This manual will help you install, set up, and administer Order Management. It’s 
divided into the following parts:

• Part 1, Getting started, provides an overview of the Order Management 
application and explains how to install it.

• Part 2, Microsoft Dynamics GP setup, explains setup procedures you’ll need to 
complete in Microsoft Dynamics GP, such as setting up a document ID for 
orders placed through Order Management.

• Part 3, Catalog Maintenance setup, explains how to use Catalog Maintenance, 
the application you’ll use to organize your inventory items into catalogs and 
departments.

• Part 4, Order Management setup, explains how to set up Order Management 
and assign users to the appropriate roles.

• Part 5, Groups and roles reference, provides details about the SharePoint 
groups and MBF roles that are used with Order Management.

Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and suggestions.

http://go.microsoft.com/fwlink/?LinkId=185513
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This manual uses the following conventions to refer to sections, navigation, and 
other information.

Additional resources

In addition to this manual, the following documentation is included with this 
release of Business Portal.

Manuals
The following PDF manuals are included in the Documentation folder on the 
Business Portal CD.

Business Portal Installation Guide The Business Portal Installation Guide 
(BusinessPortalInstallation.pdf) provides step-by-step instructions for installing 
Business Portal.

Business Portal Administrator’s Guide The Business Portal Administrator’s 
Guide (BusinessPortalAdminGuide.pdf) explains how to set up and configure 
Business Portal.

Business Portal User’s Guide The Business Portal User’s Guide 
(BusinessPortalUsersGuide.pdf) helps users complete day-to-day tasks in Business 
Portal.

Application manuals User and Administrator manuals for each application 
installed in Business Portal are available in the Documentation folder.

Help
Help is available by clicking the Help icon button, located in the upper-right corner 
of any page. The help that is displayed depends on whether you open help from a 
Business Portal page, a Microsoft® Windows® SharePoint® Services page or a 
Microsoft Office SharePoint Server 2007 page or Microsoft SharePoint Server 2010 
page.

Business Portal help When you click the Help icon button on a Business Portal 
page, the relevant help topic for that page is displayed. You can use the search field 
on the help page to search for information. You also can click the Home icon button 
to browse the contents of the help.

The warning symbol indicates situations you should be especially aware 
of when completing tasks. Typically, this includes cautions about 
performing steps in their proper order, or important reminders about 
how other information in Business Portal or the back office might be 
affected.

Convention Description

Install Order 
Management

Italic type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as clicking items on 
a menu or a toolbar or clicking buttons in a window. This example 
directs you to go to the File menu and click Print.

Bold Bold type indicates the names of fields, tabs, menus, commands, and 
buttons, and text you should type.

Symbol Description
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SharePoint help  Many of the features included in Business Portal—such as 
document libraries, lists, announcements, links, and alerts—are provided by 
Windows SharePoint Services. General information about these features is provided 
in the Administering Business Portal help. For more detailed information, refer to 
the Windows SharePoint Services help, which can be accessed by clicking the Help 
icon button in the upper-right corner of any Windows SharePoint Services page. If 
you’re using Office SharePoint Server 2007 or Microsoft SharePoint Server 2010, 
additional help related to the SharePoint Server features also will be available.

Technical support

You can contact Microsoft Dynamics technical support online or by telephone. Go to 
www.microsoft.com/dynamics and click the CustomerSource link or call 888-477-
7877 (in the U.S. and Canada) or 701-281-0555.

Documentation feedback

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

http://www.microsoft.com/dynamics
mailto:bizdoc@microsoft.com
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Part 1: Getting started
This part of the documentation provides an overview of Order Management and 
explains how to install it.

• Chapter 1, “Overview,” explains what the Order Management application is, 
describes the features it provides, and outlines the installation and setup 
process.

• Chapter 2, “Before you install,” explains the tasks you must complete before 
installing Order Management, such as installing prerequisite software.

• Chapter 3, “Installation,” explains how to install Order Management.
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Chapter 1: Overview
The following information explains what Order Management is, describes how it 
integrates with Microsoft Dynamics GP, and provides an overview of the 
installation and setup process.

The following sections are included:

• About Order Management
• How Order Management integrates with the back office
• eConnect
• Business Portal site structure
• Installation and setup checklist

About Order Management

Order Management is a Business Portal application that provides trusted customers 
and company salespeople with the ability to enter sales orders using their web 
browsers. Once an order is placed, it is automatically transferred to Microsoft 
Dynamics GP for processing.

Using Order Management, your customers and salespeople can:

• Enter sales orders at any time of the day, any day of the week (as long as the 
Business Portal web server is running).

• Track the status of orders they’ve entered.

The Order Entry page is the
main page of Order

Management.

Use these web parts
to add items to the

order.

Use this web part to
track an order’s status.
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How Order Management integrates with the back 
office

To use Order Management, the Microsoft Dynamics GP Inventory, Receivables 
Management, and Sales Order Processing modules must be installed, registered, 
and set up. The following information provides examples of how Order 
Management integrates with these modules.

Inventory
The Item Details page in Order Management shows detailed information about an 
inventory item, such as the item’s description, unit of measure, and price. This data 
comes from the item record in the Inventory module.

Receivables Management
To finalize an order, a customer, or the salesperson entering the order, must enter 
shipping and payment information on the Complete Order page in Order 
Management. The data on this page comes from the customer’s record in the 
Receivables Management module. For example:

• When a customer chooses to charge an order to their account, the customer’s 
credit limit is verified so that the order does not put the customer over the credit 
limit defined in Receivables Management.

• The customer’s billing and shipping addresses, which are defined in 
Receivables Management, are automatically displayed on the Complete Order 
page.

The item information
you enter in Inventory is

displayed in Order
Management.

The customer’s address,
defined in Receivables

Management, automatically
appears on orders.
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Sales Order Processing
Once an order is placed in Order Management, the order is automatically saved to 
the Microsoft Dynamics GP database. Salespeople can view the order in the Sales 
Transaction Entry window in Microsoft Dynamics GP.

eConnect

Order Management uses the eConnect application to communicate with your 
Microsoft Dynamics GP databases.

eConnect is automatically installed with Order Management. For more information 
about the eConnect installation, see the Business Portal Installation Guide.

Orders entered in Order
Management can be viewed

in the Sales Transaction
Entry window.
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Business Portal site structure

Business Portal is composed of multiple web sites. The top-level site contains the 
main Home page and the administration pages for Business Portal and its 
applications. Each Business Portal center is a subsite that contains pages related to a 
particular department or role.

The following illustration shows the Business Portal site structure. (You may have 
additional center subsites in your implementation.)

You must use the top-level web site to perform administrative tasks for Business 
Portal and its applications, including Order Management. However, you can 
administer SharePoint users, groups, and content on each subsite.

For more information about site administration, refer to the Business Portal 
Administrator’s Guide.

Installation and setup checklist

You must complete the following steps to install and set up Order Management.

Task For more information, see

1. Select a deployment environment. Intranet vs. extranet deployment on 
page 11

2. Set up Secure Sockets Layer. Secure Sockets Layer on page 11

3. Verify that required Microsoft Dynamics GP 
modules are installed and registered.

Microsoft Dynamics GP modules on 
page 12

4. Install Catalog Maintenance. Install Catalog Maintenance on page 12

5. Install Order Management. Chapter 3, “Installation”

6. Complete setup tasks in Microsoft Dynamics GP. Part 2, Microsoft Dynamics GP setup

7. Complete setup tasks in Catalog Maintenance. Part 3, Catalog Maintenance setup

8. Complete setup tasks in Order Management. Part 4, Order Management setup
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Chapter 2: Before you install
The following sections describe the tasks you must complete before installing Order 
Management:

• Intranet vs. extranet deployment
• Secure Sockets Layer
• Microsoft Dynamics GP modules
• Install Catalog Maintenance

Intranet vs. extranet deployment

Business Portal can be deployed in an intranet or extranet environment. The 
environment you choose determines who can use Order Management.

Intranet An intranet is your company’s internal network. When you deploy 
Business Portal in an intranet environment, only company salespeople will be able 
to enter orders in Order Management.

Extranet An extranet is an extension of your company’s intranet that provides 
limited access to authorized outside users. When you deploy Business Portal in an 
extranet environment, both your customers and salespeople will be able to enter 
orders in Order Management.

If you decide to deploy Business Portal in your intranet, you can add external access 
at a later time.

For information about setting up intranet and extranet environments, see the 
Business Portal Installation Guide.

For information about how to give your customers and salespeople access to Order 
Management, see Chapter 12, “Groups and roles.”

Secure Sockets Layer

If you’ll be accepting credit card payments from customers, you must set up Secure 
Sockets Layer (SSL) on your Business Portal web server. SSL is a feature of Internet 
Information Services (IIS) that encrypts data, such as credit card numbers, when it is 
transmitted over the Internet, in order to prevent eavesdropping, tampering, and 
message forgery.

When you use SSL and a customer submits an order, a key (encryption value) is 
applied to the data that’s being transmitted from the customer. This key encrypts, or 
scrambles the data. When the order information is received by IIS, the same key is 
used to convert the encrypted data back to its original form.

To set up SSL, you must install a certificate and a private key on your Business 
Portal web server. For more information, refer to the IIS Operations Guide, available 
on Microsoft TechNet (www.microsoft.com/technet). Refer to the Business Portal 
Administrator’s Guide for instructions on how to configure SSL for Business Portal.

If you won’t be accepting credit card payments in Order Management, SSL is not 
required. Orders will be charged to customers’ accounts.

http://www.microsoft.com/technet
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Microsoft Dynamics GP modules

Before installing Order Management, verify that the following Microsoft Dynamics 
GP modules are installed, registered, and set up:

• Inventory
• Receivables Management
• Sales Order Processing

For information about these modules, refer to the Microsoft Dynamics GP 
documentation.

Install Catalog Maintenance

Before installing Order Management, you must install Catalog Maintenance, which 
is the application you’ll use to organize your inventory items into catalogs and 
departments. 

Install Catalog Maintenance on a computer that has:

• An ODBC data source set up to connect to the SQL Server computer for 
Microsoft Dynamics GP.

• Microsoft .NET Framework 2.0 or later installed.

Use the following steps to install Catalog Maintenance.

1. From the Business Portal installation media, double-click the CDSetup.exe file.

2. The main Business Portal installation screen should appear. Click Catalog 
Maintenance.

3. The Custom Setup window appears. Specify the folder where you want the 
Catalog Maintenance files installed. The default folder is C:\Program 
Files\Microsoft Dynamics\Catalog Maintenance. To select a different folder, 
click Browse. 

After you have specified the installation folder, click Next.

4. The Ready to Install window appears. Click Install.

5. The Installation Complete window appears. Click Finish to close the wizard.
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Chapter 3: Installation
Use the following information to install Order Management:

• User rights for installation
• Windows user in the Dyngrp role
• Install Order Management

User rights for installation

To install Order Management, you must log on to the Business Portal web server as 
a user with the following access rights:

Administrators group You must be a member of the Administrators group on 
the server.

Administrator rights for SQL Server During the installation, you will be 
prompted to enter SQL Server connection information. 

• If you want to connect to SQL Server using Windows Trusted Authentication, 
you must log on to the Business Portal web server with a Windows logon ID 
that has administrative rights to SQL Server.

• If you want to connect to SQL Server using SQL Server Authentication, you’ll 
need to enter a SQL Server administrator logon ID and password during the 
installation.

Windows user in the Dyngrp role

When you install Order Management, you will be asked to specify a Windows user 
that is assigned to the Dyngrp user role in both the DYNAMICS database and each 
of your company databases. This user account is used by Order Management to 
communicate with the Microsoft Dynamics GP databases.

Install Order Management

If you did not install Order Management when running the Business Portal 
installation wizard, use the Setup Wizard to add it to your Business Portal 
installation. If you’ve installed Business Portal on multiple web servers, you must 
add Order Management to each of the web servers.

Before installing
Before you can install Order Management, you must enter registration keys for it in 
the back office. You can view the applications you’re registered for using the 
Microsoft Dynamics GP Options window. Refer to your Microsoft Dynamics GP 
documentation for more information.

To install Order Management
To install Order Management, you must run the Setup Wizard. To start the Setup 
Wizard, use one of the following methods:

• From the Business Portal installation media on your web server computer, 
double-click the CDSetup.exe file. Under Install, click Business Portal for 
Microsoft Dynamics GP. Click Add/Remove Features.
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• Open the Add or Remove Programs control panel and select Business Portal 
for Microsoft Dynamics GP 2010. Click Change to open the Modify Business 
Portal Installation window. Click Add/Remove Features. 

For detailed instructions, refer to the “Additional Applications” chapter of the 
Business Portal Installation Guide.



P
A

R
T

 2
: M

IC
R

O
S

O
FT

 D
Y

N
A

M
IC

S
 G

P
 S

E
T

U
P



16 O R D E R M A N A G E M E N T A D M I N I S T R A T O R ’ S G U I D E

Part 2: Microsoft Dynamics GP 
setup
To use Order Management, the Microsoft Dynamics GP Inventory, Receivables 
Management, and Sales Order Processing modules must be set up. Refer to each 
module’s documentation for complete setup instructions. 

After the modules have been set up, refer to the following information. which 
describes specific setup tasks you’ll need to complete in Microsoft Dynamics GP. 
It’s important that you complete these tasks so that Order Management functions 
appropriately.

• Chapter 4, “Items,” helps you enter item information in Microsoft Dynamics 
GP, such as an item’s description, price, and location.

• Chapter 5, “Document type IDs,” helps you create a document type ID to assign 
to orders placed through Order Management.

• Chapter 6, “Credit cards,” describes how to set up the credit cards that you will 
accept for payment in Order Management.

• Chapter 7, “Customer-specific pricing,” explains how to sell an item at different 
prices to different customers. For example, you can sell a computer for $2,500 to 
a retail customer, and sell the same computer for $1,500 to a wholesale 
customer.
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Chapter 4: Items
The item information you enter in Microsoft Dynamics GP is displayed on your 
Order Management pages. The following sections will help ensure that you have 
the appropriate item information entered in Microsoft Dynamics GP, so that your 
Order Management pages look the way you want them to.

• Assign items to a site
• Enter item names and descriptions
• Enter item prices
• Enter unit of measure descriptions
• Display item images

Assign items to a site

The items that you’ll sell through Order Management must be assigned to a 
inventory site. You can assign items to a site using Microsoft Dynamics GP. 

Use the following steps to assign each item you’ll sell through Order Management 
to a site.

1. Open the Item Quantities Maintenance window.
Cards > Inventory > Quantities/Sites

2. Enter or select an item number.

3. Enter or select an inventory site in the Default Site ID field.

4. Click Save. 

Repeat these steps for each item you’ll sell through Order Management.

Enter item names and descriptions

The Item Details page in Order Management displays an item’s name and 
description.

Item name

Item description
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The item name that is displayed is taken from the Description field in the Microsoft 
Dynamics GP Item Maintenance window. The description is taken from the 
Additional Information field in the Internet Information window.

Use the following steps to enter an item’s name and description in Microsoft 
Dynamics GP.

1. Open the Item Maintenance window.
Cards > Inventory > Item

2. Enter or select an item number.

3. In the Description field, enter a name or brief description of the item.

4. Click the Internet Information icon.

5. The Internet Information window appears. Enter a description of the item in the 
Additional Information field.

6. Click Save. Close the Internet Information window.

7. The Item Maintenance window is redisplayed. Click Save.

Enter item prices

When you complete setup tasks in Order Management (as described in Chapter 13, 
“Order Management setup options”), you’ll select whether you want to use the List 
Price method or Customer Pricing method. The method you select determines the 
prices items are sold for in Order Management.

If you are using extended pricing in Microsoft Dynamics GP, items that are assigned to price 
groups will not appear in Order Management. You must assign items to price sheets 
individually in order for them to appear in Order Management.

List Price method
If you use the List Price method, items will be sold according to the price methods 
and price lists that are defined in Microsoft Dynamics GP. For information on how 
to set up standard pricing, search for “standard price lists” in the Microsoft 
Dynamics GP Inventory Control documentation.

An item’s price is
determined by the

pricing method you
select: List Price or
Customer Pricing.
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Customer Pricing method
If you use the Customer Pricing method, you can sell the same item at different 
prices to different customers. For example, you can sell a computer for $2,500 to a 
retail customer, and sell the same computer for $1,500 to a wholesale customer.

For information on how to set up customer-specific pricing in Microsoft Dynamics 
GP, see Chapter 7, “Customer-specific pricing.”

Enter unit of measure descriptions

The Order Management Item Details page displays the units of measure in which 
each item can be purchased, such as Each or Case. 

If you’d rather display a description of the unit of measure, instead of just the unit 
of measure, use the following steps to enter a description in the Microsoft Dynamics 
GP Unit of Measure Schedule Setup window.

Quantities must be measured in whole units. Decimals can’t be used. Customers must enter 
the quantity as a whole number. If a customer requires a quantity containing a decimal 
place, you'll have to enter the order in the Microsoft Dynamics GP Sales Transaction Entry 
window.

1. Open the Unit of Measure Schedule Setup window.
Microsoft Dynamics GP menu > Tools > Setup > Inventory > Unit of 
Measure Schedule

2. Enter or select a unit of measure schedule ID.

Unit of measure

Unit of measure
description
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3. Click the Show Details button.

4. In the U of M Long Description field, enter a description for the unit of 
measure. This description will appear on the Item Details page in Order 
Management.

For example, if you enter a description for the Case unit of measure, the 
description will appear on the Item Details page instead of the word “Case.”

5. Click Save.

Display item images

The Order Management Item Details page can display images of your items.

The image files displayed on this page must be .gif, .bmp, .jpg, or .png files.

Show Details/Hide 
Details button

This description will appear
on the Item Details page in

Order Management.

Item image
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To display item images, you’ll need to:

• Save your item images in a folder on the Business Portal web server. We 
recommend that you use the following folder:

\Program Files\Microsoft Dynamics\Business 
Portal\Applications\OrderManagement\Images

• Specify each item’s image file name in the Microsoft Dynamics GP Internet 
Information window.

• Specify the location of the image files on the Business Portal Order 
Management Setup page.

The following procedures will help you complete these tasks.

To save your item images on the Business Portal web 
server:
1. On the Business Portal web server, go to the following folder: 

\Program Files\Microsoft Dynamics\Business 
Portal\Applications\OrderManagement\Images

2. Copy your item images to this folder.

To specify an item’s image file name:
1. Open the Item Maintenance window.

Cards > Inventory > Item

2. Enter or select an item number.

3. Click the Internet Information icon.

4. The Internet Information window appears. In the Image field, enter the selected 
item’s image file name.

5. Click Save. Close the Internet Information window.

6. The Item Maintenance window is redisplayed. Click Save.

To specify the location of the image files:
You’ll specify the location of your image files when selecting setup options on the 
Business Portal Order Management Setup page. For more information, see Image 
options on page 59.
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Chapter 5: Document type IDs
All documents in Sales Order Processing are assigned a document type ID. For 
example, you may be using the STDORD document type ID for orders and the 
STDINV document type ID for invoices.

When you set up Order Management (in Chapter 13, “Order Management setup 
options”), you’ll need to select a document type ID for orders placed through Order 
Management. You may want to select an existing document type ID, such as 
STDORD; or, you many want to create a new document type ID specifically for 
Order Management orders.

If you want to create a new document type ID for Order Management orders, refer 
to the following sections:

• Allocation methods and quantity shortages
• Create a document type ID

Allocation methods and quantity shortages

As part of creating a document type ID, you’ll need to select an allocation method. 
The allocation method you choose determines whether quantity shortages are 
addressed in Order Management.

Line Item If you select this allocation method, items will be allocated when users 
click the Check Out button on the Shopping Cart page of Order Management. If a 
quantity shortage exists for an item, the quantity shortage will be handled 
according to the quantity shortage option you select on the Order Management 
Setup page. For more information, see Document type and quantity shortage options on 
page 54.

If you’re tracking serial or lot numbers for an item, those items will not be allocated by 
Order Management. You must use Microsoft Dynamics GP to allocate those items.

You can create a new
document type ID, or select

an existing ID to assign to
Order Management orders.
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Document/Batch If you select this allocation method, quantity shortages will 
not be addressed in Order Management. Items will be allocated—and quantity 
shortages addressed—when you allocate entire documents or batches using the 
Microsoft Dynamics GP Sales Allocation-Fulfillment Options window.

None If you select this option, quantity shortages will not be addressed in Order 
Management. Items won’t be allocated (and quantity shortages won’t be addressed) 
until the order has been transferred to an invoice, fulfillment order, or back order.

Create a document type ID

Use the following steps to create a document type ID. When you set up Order 
Management (in Chapter 13, “Order Management setup options”), you’ll need to 
select this document type ID to assign it to orders placed through Order 
Management.

1. Open the Sales Order Processing Setup window.
Microsoft Dynamics GP menu > Tools > Setup > Sales > Sales Order 
Processing 

2. Click Order to open the Sales Order Setup window.

3. In the Order ID field, enter a new document type ID to identify orders placed 
through Order Management. 

For example, you may want to enter OMORD to indicate the order originated 
in Order Management, or BPORD to indicate the order originated within 
Business Portal.

4. Enter the next document number, such as 0001.

5. Complete the setup, including selecting an allocation method. The allocation 
method you choose affects when quantity shortages are addressed. For more 
information, see Allocation methods and quantity shortages on page 23.

For detailed information about the fields on this window, see the online help 
(Help > About This Window).

6. Click Save. 
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Chapter 6: Credit cards
To accept credit card payments in Order Management, you’ll need to enter 
information about each credit card type in Microsoft Dynamics GP. The following 
information explains how to do so:

• Set up credit cards
• Credit card validation
• Secure Sockets Layer

Set up credit cards

The following credit cards can be accepted in Order Management:

• Visa
• MasterCard
• American Express
• Discover
• Diners Club
• JCB

Use the following steps to set up a credit card in Microsoft Dynamics GP.

1. Open the Credit Card Setup window.
Microsoft Dynamics GP menu > Tools > Setup > Company > Credit Cards

2. Enter a card name. 

Depending on which credit card you’re setting up, you must enter the name as 
follows.

3. Select the Accepted from Customers check box.

4. Select the Charge Card option and select the General Ledger account that will 
track payments made with this charge card. The account must be a credit card 
receivables account.

Payments made with charge cards are treated as accounts receivable amounts. 
They must be submitted to the credit card company, and the reimbursement 
must be received, before the payment is considered received. 

Do not assign an intercompany account to the credit card; Order Management doesn’t 
support intercompany transaction processing.

5. Click Save.

Credit card type You must enter this name

Visa VISA

MasterCard MasterCard

American Express Amex

Discover Card Discover

Diners Club Diners Club

JCB JCB
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Credit card validation

Order Management does not validate the credit card numbers your customers enter 
on their orders. If you are accepting credit card payments in Order Management, 
consider using a third-party application for credit card validation.

Secure Sockets Layer

To accept credit card payments from customers, you must set up Secure Sockets 
Layer (SSL) on your Business Portal web server. For more information, see Secure 
Sockets Layer on page 11.
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Chapter 7: Customer-specific pricing
When you set up Order Management (in Chapter 13, “Order Management setup 
options”), you’ll need to select a pricing method. If you choose the Customer 
Pricing method, you can sell the same item at different prices to different customers. 
For example, you can sell a computer for $2,500 to a retail customer, and sell the 
same computer for $1,500 to a wholesale customer.

To offer customer-specific pricing in Order Management, complete the following 
procedures in Microsoft Dynamics GP.

• Create a price level
• Add a price level to a price list
• Assign a price level to a customer record

Create a price level

A price level is a category of prices. It is used to specify different prices for different 
groups of customers. For example, you might want to create a Retail price level for 
retail customers, and a Wholesale price level for wholesale customers. 

Use the following steps to create a price level.

1. Open the Price Level Setup window.
Microsoft Dynamics GP menu > Tools > Setup > Inventory > Price Level

2. Enter a name and description for the price level.

3. Click Save.

Add a price level to a price list

A price list contains all the prices for a particular item. For example, a price list can 
contain an item’s retail price and wholesale price.

Use the following steps to add a price level to an item’s price list.

1. Open the Item Price List Maintenance window. 
Cards > Inventory > Price List

2. Enter or select an item number.

3. In the tree view, expand the item’s price list information.
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4. Determine where in the price list’s hierarchy you want to add the price level:

• If the price list includes pricing for multiple currencies, select a currency in 
the tree view.

• If the price list includes only one currency, select the item number in the tree 
view.

5. Place your cursor in the first blank line in the scrolling window. 

6. Enter or select the price level you created in Create a price level on page 27.

7. Enter or select a unit of measure.

8. Enter pricing information.

Your entries are saved automatically as soon as they’re entered in the scrolling 
window. You can click Save to clear the window, or you can continue to add to 
the price list—entering pricing information for other currencies, if needed.

9. When you’ve finished entering pricing information, choose File > Print to 
generate the Item Price List report and verify your entries.

Repeat these steps for each item you want to sell at the new price level.

Assign a price level to a customer record

To assign customer-specific pricing, you must assign a price level to a customer 
record. Use the following steps to do so.

If a price level is not specified in the customer record, the price level specified in the 
Receivables Management Setup window will be used to calculate an item’s price.

1. Open the Customer Maintenance window.
Cards > Sales > Customer

2. Enter or select the customer you want to assign the price level to.

Place your cursor here.
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3. In the Price Level field, enter or select the price level you created in Create a price 
level on page 27.

For example, suppose you added the WHOLESALE price level to the A100 
Audio System’s price list, and then assigned the WHOLESALE price level to 
Aaron Fitz Electrical’s customer record. When Aaron Fitz logs on to Order 
Management, he’ll be able to buy the A100 Audio System at the wholesale 
price.

4. Click Save.

Aaron Fitz Electrical can 
now buy items at 
wholesale prices.
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Part 3: Catalog Maintenance setup
Use Catalog Maintenance to organize your inventory items into catalogs and 
departments, so that customers can easily browse through your inventory and find 
the items they want to order.

The following information explains how to use Catalog Maintenance:

• Chapter 8, “Catalogs and departments,” explains how to create a master catalog 
and departments.

• Chapter 9, “Items,” describes how to assign items to each department.

• Chapter 10, “Display options,” explains how to change the way item 
information is displayed in Catalog Maintenance.

• Chapter 11, “Catalog Maintenance administration tasks,” contains procedures 
you may use to help administer and manage Catalog Maintenance.
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Chapter 8: Catalogs and departments
The Order Entry page in Order Management displays categories of inventory items. 
These categories are defined in Catalog Maintenance. 

To begin defining these categories, you’ll need to set up a catalog structure. A 
catalog structure consists of a master catalog and departments. The following 
sections explain how to create these elements.

• Create a master catalog
• Create departments
• Copy departments
• Delete master catalogs and departments

Create a master catalog

The first step in organizing your inventory items is to set up a master catalog. A 
master catalog is at the top of the catalog hierarchy. It contains all the departments 
that you’ll categorize your items into.

You can create an unlimited number of master catalogs. However, only one catalog 
can be used at a time. For example, suppose you sell different products at different 
times of the year. You could create spring, summer, fall, and winter master catalogs. 
To specify which catalog you want to use, you’ll need to mark it as the default 
catalog.

Use the following steps to create a master catalog.

These item categories
are defined in Catalog

Maintenance.

Master catalog
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1. Open Catalog Maintenance. 
Start > All Programs > Microsoft Dynamics > Catalog Maintenance > Catalog 
Maintenance

2. The Login window appears. Select a data source name to connect to the SQL 
server for Microsoft Dynamics GP. Then enter your SQL Server® user name and 
password. Click OK.

3. The Company Select window appears. Select the company for which you’ll 
organize inventory items. Click OK.

The Microsoft Dynamics GP Catalog Maintenance window appears. 

4. Choose File > New > Master Catalog. The Master Catalog Properties window 
appears.

5. Enter an ID for the catalog.

6. If this is the master catalog you currently want to use with Order Management, 
select the Default Catalog check box.

7. Enter the catalog’s name in the Name field.

8. Enter a brief description of the catalog in the Description field.

9. You can enter a longer description of the catalog in the Extended Description 
field.

The Image Path, User-Defined 1, and User-Defined 2 fields are not supported at this 
time.

10. Click OK.

Create departments

Master catalogs contain departments. These departments are the categories that you 
see on the Order Entry page of Order Management.

These item categories are
the departments you set up

in Catalog Maintenance.
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A department can contain sub-departments or items. (A department cannot contain 
both sub-departments and items.)

Use the following steps to create a department.

1. In the console tree, select the master catalog or department you want the new 
department to appear beneath.

2. Choose File > New > Department. The Department Properties window 
appears.

3. Enter an ID for the department.

4. Enter the department’s name in the Name field.

5. Enter a brief description of the department in the Description field.

6. You can enter a longer description of the department in the Extended 
Description field.

The Image Path, User-Defined 1, and User-Defined 2 fields are not supported at this 
time.

7. Click OK.

Copy departments

You can copy a department and paste it into another area of your catalog structure.

When you copy a department, you copy it and all of its sub-departments and 
assigned items. You can then paste the department (including its sub-departments 
and assigned items) into another department.

Use the following steps to copy a department.

1. In the console tree, select the department you want to copy.

2. Click the Copy button on the toolbar.

The selected department, along with its sub-departments and assigned items, 
will be copied to the Clipboard.

This department contains 
sub-departments.

This department 
contains items.
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3. In the console tree, select the department you want to copy the department 
(from step 1) into. You cannot paste it into a department that already has 
assigned items.

4. Click the Paste button on the toolbar.

Delete master catalogs and departments

Use the following steps to delete a master catalog or department.

Keep in mind, when you delete a master catalog or department, all of its sub-
departments are also deleted.

1. In the console tree, select the master catalog or department you want to delete.

2. Click the Delete button on the toolbar. 

3. A dialog box appears, asking you to confirm the removal. Click Yes.
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Chapter 9: Items
Once you’ve set up a master catalog and departments (as described in Chapter 8, 
“Catalogs and departments”), you can assign your inventory items to the 
departments. The following information explains how to assign items to 
departments:

• Assign individual items to a department
• Assign a group of items to a department
• View details about an item

Assign individual items to a department
You can assign items to a department on an individual basis, or you can create a 
group of items and assign the group to the department. The following steps explain 
how to assign items to a department on an individual basis.

1. In the console tree, select the department you want to assign an item to.

You cannot assign an item to a department that contains sub-departments.

2. Find the Change View - Marked/Unmarked button on the toolbar. This button 
acts as a toggle switch. By clicking it you can display:

• All inventory items
• Marked items (items that have been assigned to the department)
• Unmarked items (items that have not been assigned to the department)

Click the Change View - Marked/Unmarked button until all items are 
displayed.

Change View - Marked/
Unmarked button

The status bar indicates whether marked 
items, unmarked items, or all items are 
displayed.
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3. Double-click the item you want to assign to the department. The item name will 
appear in bold type, indicating that the item has been assigned to the 
department.

Repeat this step for each item you want assigned to the department.

Assign a group of items to a department

If you have several items to assign to a department, you may want to create an item 
group, and assign it to a department. An item group is a collection of inventory 
items that meet specific criteria. For example, you can create an item group for all 
items that contain the word “phone” in their item descriptions, or for all items 
whose item number is greater than 500.

When a new item is added to Inventory in Microsoft Dynamics GP—and it meets 
the criteria set up for the item group—the item is automatically added to the group.

To create an item group:
1. Choose File > New > Item Group. The Item Group Maintenance window 

appears.

2. Enter a name for the item group.

3. Enter a brief description of the item group.

4. To specify which items will be included in the group, select a field, select an 
operator, and enter a value. 

For example, to create an item group for all items that contain the word 
“phone,” you could enter the following information:

Field: Description

Operator: Equal to

Value: phone

Select the Match Case check box if the information you entered in the Value 
field is case-sensitive.

5. Click Save.

To assign an item group to a department:
1. In the console tree, select the department you want to assign the item group to.

You cannot assign an item group to a department that contains sub-departments.
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2. Find the Change View - Items/Groups button on the toolbar. This button acts 
as a toggle switch. By clicking it you can display:

• Items 
• Items groups
• Items and item groups

Click the Change View - Items/Groups button until item groups are displayed.

3. Double-click the item group you want to assign to the department. The group 
name will appear in bold type, indicating that the item group has been assigned 
to the department.

View details about an item

Use the following steps to view details about an item, such as the item’s description, 
price, and quantity available information.

1. In the details pane, right-click an item. Choose Properties.

2. The Item Inquiry window appears, displaying details about the item, such as its 
description, price, and quantity available. 

You can’t modify the information in this window. If you need to make changes 
to the data, you’ll need to make the changes in Microsoft Dynamics GP.

3. Click OK to close the window.

Change View - Items/
Groups button

Item group

The status bar indicates whether items,
item groups, or both are displayed.
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Chapter 10: Display options
There are several ways to display item information in the details pane of Catalog 
Maintenance. The following sections describe each display option:

• Items vs. item groups
• Marked vs. unmarked
• List vs. details
• Modify the data block
• Set up item filters
• Delete item filters

Items vs. item groups

The Change View - Items/Groups button on the toolbar acts as a toggle switch. By 
clicking it, you can display:

• Items 
• Items groups
• Items and item groups

The status bar at the bottom of Catalog Maintenance indicates whether you are 
viewing items, item groups, or both.

Change View - Items/
Groups button

The status bar indicates whether items,
item groups, or both are displayed.
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Marked vs. unmarked
The Change View - Marked/Unmarked button on the toolbar acts as a toggle 
switch. By clicking it you can display:

• Marked items (items that have been assigned to the selected department)
• Unmarked items (items that have not been assigned to the selected department)
• All items

The status bar at the bottom of Catalog Maintenance indicates whether you are 
viewing marked items, unmarked items, or both.

Change View - Marked/
Unmarked button

The status bar indicates whether marked items, 
unmarked items, or both are displayed.
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List vs. details
The item information in the details pane can be displayed in a list view or details 
view.

List view Click the View List button on the toolbar to display the items in a list.

Details view Click the View Details button on the toolbar to display the 
description, class, and type of each item.

View List button

Item information is
displayed in a list.

View Details button

The description, class,
and type of each item is

displayed.
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Modify the data block

When you start Catalog Maintenance for the first time, up to 1000 items will be 
displayed in the details pane. You can change this number by modifying the data 
block. The data block defines how many items will be displayed in the details pane 
at one time. 

For example, you can modify the data block to display 10 items in the details pane. 
You can then use Previous Block and Next Block buttons to view the previous or 
next “block” of 10 items.

Use the following steps to modify the data block.

1. Click the Find Data Block button on the toolbar. The Find Item/Set Page Size 
window appears.

2. If you want a specific item to be the first item listed in the data block, enter the 
item’s number.

3. Enter the number of items you want in the data block (that is, the number of 
items per page).

4. Click OK.

5. The data block is displayed in the details pane. To view the previous data block, 
click the Previous Block button on the toolbar. To view the next data block, click 
the Next Block button.

Set up item filters

To limit the number of items displayed in the details pane, you can set up an item 
filter. When you select a department in the console tree that has an item filter 
applied to it, only the items that meet specific criteria (which you define when 
setting up the filter) will be displayed in the details pane.

For example, your company may have thousands of inventory items, but only 100 
of those items are telephones. You can set up an item filter so that when you select 
the Telephones department in the console tree, only telephones are displayed in the 
details pane.

When you set up an item filter, it applies to the department that is selected in the 
console tree, as well as the departments above and below it. For example, let’s say 
you have the following catalog structure:
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If you select Office Phones and set up an item filter, the item filter will be applied to 
these departments: Telephones, Office Phones, Employee Phones, and Conference 
Room Phones.

Use the following steps to set up an item filter.

1. In the console tree, select the department you want the item filter applied to. 
Keep in mind, the item filter will be applied to all departments above and below 
the department you select.

2. Choose Edit > Department Tree Item Filter. The Item Filter Maintenance 
window appears.

3. To specify which items will be displayed, select a field, select an operator, and 
enter a value. 

For example, to display only telephones, you could set up the item filter so that 
only items with the word “phone” in their descriptions will be displayed. Your 
entries would look like this:

Field: Description

Operator: Equal to

Value: phone

Select the Match Case check box if the information you entered in the Value field is 
case-sensitive.

4. Click Save.

The name of the left-most department the item filter is applied to will appear 
highlighted.

Delete item filters

If you set up an item filter, and now wish to delete it, complete the following steps.

1. In the console tree, right-click the department the item filter is applied to.

2. Choose Item Filter.

3. The Item Filter Maintenance window appears. Click Delete.

The highlighting indicates
that an item filter has been
applied to this department

and the departments below it.
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Chapter 11: Catalog Maintenance administration 
tasks
The following procedures will help you administer and manage Catalog 
Maintenance.

• Install sample data
• Remove and reinstall the Catalog Maintenance tables

Install sample data

Sample data is available to use with Catalog Maintenance. Use the following steps 
to install (or reinstall) the sample data.

1. Open Catalog Maintenance. 
Start > All Programs > Microsoft Dynamics > Catalog Maintenance > Catalog 
Maintenance

2. The Login window appears. Select a data source name to connect to the SQL 
server for Microsoft Dynamics GP. Then enter your SQL Server user name and 
password. Click OK.

3. The Company Select window appears. Select the company for which you’ll add 
sample data. Click OK.

The Microsoft Dynamics GP Catalog Maintenance window appears. 

4. Choose Edit > File Maintenance > Install Sample Data.

5. A dialog box appears, informing you that any changes you made to the sample 
data (that is, if the sample data was already installed) will be overwritten. Click 
Yes to continue.

After the sample data is installed, a sample catalog appears in the console tree.

Remove and reinstall the Catalog Maintenance tables

If you’ve been using Catalog Maintenance in a testing environment, you may have 
created several test catalogs. To delete all your test catalogs and departments at one 
time, you can remove the Catalog Maintenance SQL tables, and then reinstall them. 
The following steps explain how to do so.

1. Open Catalog Maintenance. 
Start > All Programs > Microsoft Dynamics > Catalog Maintenance > Catalog 
Maintenance

2. The Login window appears. Select a data source name to connect to the SQL 
server for Microsoft Dynamics GP. Then enter your SQL Server user name and 
password. Click OK.

3. The Company Select window appears. Select the company for which you’ll 
remove and reinstall the Catalog Maintenance tables. Click OK.

The Microsoft Dynamics GP Catalog Maintenance window appears. 
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4. Choose Edit > File Maintenance > Create/Drop Tables.

5. The File Maintenance window appears. Click Drop Tables.

6. A dialog box appears, informing you that all catalog data will be removed. 
Click Yes to continue.

Catalog Maintenance will close.

7. Restart Catalog Maintenance.
Start > All Programs > Microsoft Dynamics > Catalog Maintenance > Catalog 
Maintenance

8. The Login window appears. Select a data source name to connect to the 
Microsoft Dynamics GP SQL Server. Then enter your SQL Server user name and 
password. Click OK.

9. The Company Select window appears. Select the company for which you’ll 
organize inventory items. Click OK.

10. The File Maintenance window appears. Click Create Tables.

Catalog Maintenance opens. You can install sample data and work with the 
sample catalog, or you can create your own catalog. For more information, see 
Install sample data on page 47 and Chapter 8, “Catalogs and departments.”
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Part 4: Order Management setup
This part of the documentation explains setup procedures you must complete in 
Order Management. Specifically, it explains how to assign Order Management users 
to groups and roles, and how to configure the options on the Order Management 
Setup page.

• Chapter 12, “Groups and roles,” explains how to set up your Order 
Management users and assign them to SharePoint groups and Microsoft 
Business Framework roles.

• Chapter 13, “Order Management setup options,” explains how to configure the 
options on the Order Management Setup page. For example, these options 
determine how quantity shortages, payments, and commissions are handled for 
orders entered in Order Management.

• Chapter 14, “Order Management URLs,” includes information about the URLs 
you’ll need to provide to your salespeople and customers so they can access 
Order Management.

• Chapter 15, “Troubleshooting,” lists common issues you may encounter with 
Order Management, and possible solutions.
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Chapter 12: Groups and roles
To use Business Portal, all users must be assigned to both SharePoint groups and 
Microsoft Business Framework (MBF) roles. SharePoint groups determine the 
access users have to sites and pages, while MBF roles determine the access that 
users have to data.

There are three main categories of Order Management users: customers, 
salespeople, and Order Management administrators. The following information 
explains the SharePoint groups and MBF roles you’ll need to assign these users to.

• Customers
• Salespeople
• Order Management administrators

Only the Business Portal administrator can assign users to SharePoint groups and MBF 
roles, so you’ll need to work with that administrator. Step-by-step instructions are provided 
in the Business Portal Administrator’s Guide.

Customers

To give your customers access to Order Management via an extranet, create 
Windows user accounts for them. Then assign them to SharePoint groups and MBF 
roles.

Windows accounts
You must set up Windows user accounts for the customers who will be accessing 
Order Management. The accounts must be domain accounts or local accounts on 
the Business Portal web server. For more information about setting up these 
accounts, see the Business Portal Administrator’s Guide.

SharePoint groups and MBF roles
To give your customers access to Order Management, you must assign them to the 
following SharePoint groups and MBF roles.

Salespeople

To give your salespeople access to Order Management, you must assign them to the 
following SharePoint groups and MBF roles.

SharePoint group MBF roles

BP Order Management Customer Order Management Customer

Customer (advanced role)

SharePoint group MBF roles

BP Order Management Salesperson Order Management Salesperson

Salesperson (advanced role)
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Order Management administrators

Order Management administrators are the users responsible for setting up and 
maintaining Order Management. Order Management administrators must be 
assigned to the following SharePoint group and MBF role.

Keep in mind, Order Management administrators won’t be able to enter orders. To enter 
orders, users must be assigned to the appropriate customer and salesperson MBF roles. For 
more information, see Customers on page 51 and Salespeople on page 51.

SharePoint group MBF role

BP Order Management Administrator Order Management Admin
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Chapter 13: Order Management setup options
To configure the Order Management application, go to the Order Management 
Setup page. (You can access this page by going to the Administration Home page on 
the Business Portal web site. Under Order Management, click Order Management 
setup.)

Configure the following options:

• Inventory options
• Document type and quantity shortage options
• Display options
• Batch creation options
• Shipping options
• Customer options
• Commission options
• Payment options
• Image options

Inventory options

On the Order Management Setup page, configure the following inventory options:

Order from Site Click the lookup button to open the Sites page. Select the site 
that will be used for allocating item quantities for each order. 

If you’re allocating by line item, and a quantity shortage exists at this site, the 
shortage will be handled according to the option you select in Document type and 
quantity shortage options on page 54.

If you’re allocating by document or batch, quantity shortages will not be addressed 
in Order Management. For more information, see Allocation methods and quantity 
shortages on page 23.

Display Quantity Available Select this check box if you want to display the 
quantity available for each item on the Items page.

Display Quantities for If you selected the Display Quantity Available check 
box, specify whether you want an item’s quantity available information to represent 
the total inventory from all sites, or only the total inventory from the site you 
selected in the Order from Site field.
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Document type and quantity shortage options

On the Order Management Setup page, configure the following options:

Document Type ID Select the document type ID you created for orders placed 
through Order Management. (This is the ID you created in Chapter 5, “Document 
type IDs.”)

Item Quantity Shortage If the document type ID that you selected is 
configured to allocate by line item, you must select one of the following options for 
processing item quantity shortages.

If the document type ID that you selected is configured to allocate by document or 
batch, quantity shortages will not be addressed in Order Management. For more 
information, see Allocation methods and quantity shortages on page 23.

Select this option To:

Override Shortages Sell the quantity entered, regardless of the quantity available at the 
site selected in the Order from Site field.

The quantity will appear in the Qty to Invoice field in the Microsoft 
Dynamics GP Sales Transaction Entry window. The quantity will 
appear as a negative number in the Quantity Available field in the 
Item Maintenance window.

Back Order All Back order the entire quantity for the item. For example, if a 
customer ordered 30 items, and you have only 25 in inventory at the 
selected site, you will back order all 30 items.

The quantity will appear in the Quantity Ordered and Qty to Back 
Order fields in the Microsoft Dynamics GP Sales Transaction Entry 
window. You’ll have to transfer the document to create the back 
order.

Back Order Balance Back order the quantity that isn’t available. For example, if a 
customer ordered 30 items, and you have only 25 in inventory at the 
selected site, you’d sell the 25 items you have on hand and back 
order the remaining five. 

Thirty will appear in the Quantity Ordered field, 25 will appear in 
the Qty to Invoice field, and five will appear in the Qty to Back 
Order field in the Microsoft Dynamics GP Sales Transaction Entry 
window. You’ll have to transfer the document to create the back 
order.

Cancel All Cancel the entire item quantity. 

The quantity will appear in the Quantity Canceled field in the 
Microsoft Dynamics GP Sales Transaction Entry window.
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Kit Quantity Shortage If the document type ID that you selected is configured 
to allocate by line item, select one of the following options for processing kit 
quantity shortages.

Display options

On the Order Management Setup page, configure the following display options:

Display Tax Detail Select this check box if you want salespeople and customers 
to see tax details on their orders.

Display Price Options Based on Select one of the following options.

Select this option To:

Override Shortages Sell the quantity entered, regardless of the quantity at the site 
selected in the Order from Site field. The quantity shortage for 
every component in the kit will be overridden. 

The quantity will appear in the Qty to Invoice field in the Microsoft 
Dynamics GP Sales Transaction Entry window. The quantity will 
appear as a negative number in the Quantity Available field in the 
Item Maintenance window.

Back Order All Back order all the components of the kit item. For example, let’s say 
you have a kit with three component items, one of which is out of 
stock. If a customer tries to purchase the kit item, the entire quantity 
of all components will be back ordered. 

The quantity will appear in the Quantity to Back Order field in the 
Microsoft Dynamics GP Sales Transaction Entry window; the 
component quantity will appear in the To Back Order field for 
each component in the Sales Kit Options window. The kit quantity 
will remain the same so that you can view the original quantity 
requested. You’ll have to transfer the document to create the back 
order.

Cancel All Cancel the entire kit quantity. 

The quantity will appear in both the document quantity field and the 
Quantity Canceled field in the Sales Transaction Entry window 
and the component quantity will appear in the Quantity Canceled 
field for each component in the Sales Kit Options window.

Select this option To:

Customer Pricing Method Sell the same item at different prices to different customers. For 
example, you can sell a computer for $2,500 to a retail customer, 
and sell the same computer for $1,500 to a wholesale customer.

If you select the Customer Pricing Method option, be sure that 
you’ve set up customer-specific pricing in Microsoft Dynamics GP. 
For more information, see Chapter 7, “Customer-specific pricing.”

List Price Sell each item according to the list price defined in Microsoft 
Dynamics GP. For information on entering list prices, see Enter item 
prices on page 18.
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Number of Customers to Display per Page When a salesperson enters an 
order, he or she must specify which customer the order is for by selecting the 
customer in the Customers lookup page. Specify the number of customers you want 
listed on the Customers lookup page at one time. 

For example, if you enter 20, twenty records will be shown at one time. Users can 
click the Previous and Next links to view the previous or next twenty records.

If you enter 0, all customers will be displayed on the Customers lookup page.

Number of Items to Display per Page When a customer or salesperson 
enters an order, he or she can select an item from the Items lookup page. Specify the 
number of items you want listed on the Items lookup page at one time.

For example, if you enter 20, twenty records will be shown at one time. Users can 
click the Previous and Next links to view the previous or next twenty records.

If you enter 0, all items will be displayed in the Items lookup page.

Batch creation options

Order Management transactions are entered in Sales Order Processing batches in 
Microsoft Dynamics GP. On the Order Management Setup page, configure the 
following batch creation options:

Create a New Batch Every Specify how often a new Order Management batch 
will be created in Microsoft Dynamics GP: hourly, daily, or weekly.

Start Day If you chose to create a new batch weekly, specify the day of the week 
on which new batches will be created.

Default Batch Prefix Enter a batch prefix to identify batches containing Order 
Management transactions.

Specify how many
records to display in this

lookup window.
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Shipping options

On the Order Management Setup page, you can select one of the following shipping 
options:

Allow Shipping Address Change If you select this option, customers and 
salespeople can enter a new shipping address on orders. The new shipping address 
will be applied to the current order only—it won’t be saved for use on future orders.

To view the new shipping address in Microsoft Dynamics GP, open the Sales 
Customer Detail Entry window. Click the icon next to the Ship To Address ID field 
to view the address.

Allow Multiple Ship to Addresses per Order If you select this option, 
customers and salespeople can select a ship-to address, shipping method, and 
requested ship date for each line item on their orders.

If you don’t select one of these options, customers and salespeople must select an 
existing shipping address ID. All items on the order will be shipped to this address.

Customer options

When a salesperson enters an order for a new customer, the salesperson enters the 
customer’s address on the Add Customer page.

As the Order Management administrator, you must specify the address ID that will 
be assigned to this address in Microsoft Dynamics GP. (An address cannot be saved 
to the Microsoft Dynamics GP database without an address ID.) 

Enter the address ID in the Address ID for New Customers field on the Order 
Management Setup page.

A salesperson enters a customer’s
address on this page. As the Order

Management administrator, you
need to specify the address ID that

will be assigned to this address.
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Commission options

Use the commission options on the Order Management Setup page to specify which 
customers salespeople can enter orders for, and how commissions are credited.

Specifying which customers salespeople can enter orders 
for
To specify which customers salespeople can enter orders for, select one of the 
following options:

• If you select Assigned-to Customers only, salespeople can enter orders (and 
view order statuses) for only the customers they are assigned to.

• If you select All Customers, salespeople can enter orders (and view order 
statuses) for any customer.

Specifying how commissions are credited
If you allow salespeople to enter orders for any customer, you’ll need to specify 
how commissions are credited. Select one of the following options:

• If you select Salesperson assigned to customer, commissions are credited to the 
salesperson assigned to the customer, regardless of who enters the order. To 
view the salesperson assigned to a specific customer, open the Customer 
Maintenance window in Microsoft Dynamics GP.

• If you select Salesperson entering order, commissions are credited to the 
salesperson entering the order, regardless of whether the salesperson is 
assigned to the customer.

Payment options

Customers can pay for orders submitted through Order Management by credit card 
or on account. There is nothing you need to do to enable customers to pay on 
account. However, if you want to accept credit card payments, configure the 
following options on the Order Management Setup page:

Allow Payment by Credit Card Select this check box if you will accept credit 
card payments.

You cannot select the Allow Payment by Credit Card check box until Secure Sockets 
Layer (SSL) has been set up on your Business Portal web server. For more information about 
SSL, see Secure Sockets Layer on page 11.

User ID Click the lookup button to open the Users window. The Users window 
displays a list of Microsoft Dynamics GP user IDs. Select the user ID to associate 
with the posting of credit card payments to General Ledger. This user ID is 
primarily for audit trail purposes.
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Image options

To display images of your inventory items in Order Management, you must specify 
the location of your image files in the Image URL field. 

Use the following format:

\BusinessPortal\Applications\OrderManagement\Images

For more information on how to display images, see Display item images on page 20.
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Chapter 14: Order Management URLs
After you have set up Order Management, your salespeople and customers can 
begin entering orders. The following sections include information about the URLs 
you’ll need to provide to your salespeople and customers so they can access Order 
Management:

• URL for salespeople
• URL for customers

URL for salespeople

When you are ready for salespeople to begin using Order Management, provide 
them with the following URL:

http://<ServerName>/BP/Sales

If you’ve configured Business Portal to use Secure Sockets Layer (SSL), the URL is:

https://<ServerName>/BP/Sales

ServerName is the name of the server on which Business Portal is installed.

This URL directs users to the Sales Center Home page in Business Portal. Users can 
then click the Order Entry link on the Quick Launch to open the Order Entry page, 
where they can begin entering orders.

URL for customers

When you are ready for customers to begin using Order Management, provide 
them with the following URL:

http://<ServerName>/BP/Orders

If you’ve configured Business Portal to use Secure Sockets Layer (SSL), the URL is:

https://<ServerName>/BP/Orders

ServerName is the name of the server on which Business Portal is installed.

This URL directs users to the Order Entry page, where they can begin entering 
orders.
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Chapter 15: Troubleshooting
You may encounter problems that prevent Order Management from working 
properly. The following is a list of common issues you may encounter, and possible 
solutions.

• Problem with your order
• There are no items to display
• Updates to catalogs and departments are not displayed

Problem with your order

The Problem With Your Order page is displayed to a user when an order cannot be 
completed. To determine why an order cannot be completed, review the 
information on the Windows event viewer.

Use the following steps to display the Windows event viewer.

1. Open the Event Viewer console.
Start > Administrative Tools > Event Viewer

2. In the console tree, select Application.

3. In the details pane, double-click any errors that have Order Management in the 
Source column. 

The Event Properties window will display, providing a description of the error.

There are no items to display

Users may receive an error messaging saying, “There are no items to display” when 
trying to add items to their orders. This error may indicate that:

Order Management was not able to calculate item prices for that 
customer. Verify that a price level has been entered in the Customer 
Maintenance or Receivables Management Setup window in Microsoft Dynamics 
GP.

You need to reset your password in eConnect. During the eConnect 
installation, you entered a Windows user name and password. If the password for 
this account changed, you need to enter the new password in Component Services.

Use the following steps to enter your new password for eConnect.

1. Open the Component Services console.
Start > Administrative Tools > Component Services

2. In the console tree, choose Component Services > Computers > My Computer 
> COM+ Applications > Miscellaneous Routines for Microsoft Dynamics 
Business Portal.

3. Right-click Miscellaneous Routines for Microsoft Dynamics Business Portal 
and choose Properties.



P A R T  4 O R D E R  M A N A G E M E N T  S E T U P

64 O R D E R M A N A G E M E N T A D M I N I S T R A T O R ’ S G U I D E

4. The Miscellaneous Routines for Microsoft Dynamics Business Portal Properties 
window appears. Click the Identity tab.

5. Enter and confirm your new password. Click OK.

Updates to catalogs and departments are not 
displayed

If you’ve made updates in Catalog Maintenance—such as creating new 
departments or assigning new items to a department—and these changes aren’t 
being reflected in Order Management, users may need to delete their temporary 
Internet files.

Some Business Portal pages are cached by Internet Explorer. These temporary files 
need to be deleted so that new versions will be displayed instead.

Internet Explorer options are set per user on each computer. If multiple users share 
a single client workstation, temporary files will need to be deleted with each of the 
users logged in to the workstation.

To delete temporary Internet files:
1. Start Internet Explorer and open the Internet Options window.

Tools > Internet Options 

2. On the General tab, in the Temporary Internet files section, click Delete Files. 

3. The Delete Files window appears. Select the Delete all offline content check 
box.

4. Click OK to delete the files and close the Delete Files window. 

Deleting files may take some time, depending on the number of temporary files 
on the computer.

5. Click OK to close the Internet Options window.

If the changes you’ve made in Catalog Maintenance are still not displayed in Order 
Management, you may need to reset IIS.

To reset IIS:
1. Choose Start > Run.

2. Type iisreset. Click OK.
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Part 5: Groups and roles reference
This information provides details about the SharePoint groups and MBF roles that 
are used with Order Management.

• Chapter 16, “Default group and role permissions,” lists the default permissions 
associated with the SharePoint groups and MBF roles used with Order 
Management.
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Chapter 16: Default group and role permissions
This information lists the default permissions associated with the SharePoint 
groups and MBF roles that are used with Order Management.

For more information about SharePoint groups and MBF roles, see the Business 
Portal Administrator’s Guide.

This information is divided into the following sections:

• SharePoint groups
• MBF roles
• Advanced MBF roles

SharePoint groups

SharePoint groups are used to grant access to Business Portal sites and pages. The 
permission levels associated with each group define the level of control users have 
over the securable items on those pages, such as web parts.

SharePoint permission levels control whether users can modify SharePoint content, such as 
pages and document libraries. For example, a user who has the Read permission level for a 
page can’t modify the page or the web parts on it. Permission levels do not affect a user’s 
access to Microsoft Dynamics GP data. This means that a user with the Read permission 
level for a page still may be able to create transactions, modify records, or delete entries using 
that page.

The following table lists the SharePoint groups that are installed with Order 
Management, and includes the pages and permission levels associated with each 
group.

Group Site Page library Page Permission 
level

BP Order 
Management 
Administrator

Top-level Business 
Portal site

Order Management Pages Order Management Setup Read

Orders Order Management External Pages Complete Order Read

Item Details Read

Items Read

Order Confirmation Read

Order Details Read

Order Entry Read

Problem With Your Order Read

Shopping Cart Read

Sales Center Order Management Internal Pages Complete Order Read

Item Details Read

Items Read

Order Confirmation Read

Order Details Read

Order Entry Read

Problem With Your Order Read

Shopping Cart Read

Sales Center Common Pages Sales Center Home Contribute
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MBF roles

MBF roles are used to grant access to Business Portal data. The data permissions 
associated with each role control access to the back office data that can be displayed 
in Business Portal.

The following table lists the MBF roles that are installed with Order Management, 
and includes the data permissions associated with each role.

BP Order 
Management 
Customer

Orders Order Management External Pages Complete Order Read

Item Details Read

Items Read

Order Confirmation Read

Order Details Read

Order Entry Read

Problem With Your Order Read

Shopping Cart Read

BP Order 
Management 
Salesperson

Sales Center Order Management Internal Pages Complete Order Read

Item Details Read

Items Read

Order Confirmation Read

Order Details Read

Order Entry Read

Problem With Your Order Read

Shopping Cart Read

Sales Center Common Pages Sales Center Home Read

Group Site Page library Page Permission 
level

Role Data permissions

Order Management Admin CreditCard - All
Customer - All
CustomerClass - All
Item - All
ItemQuantities - All
SalesOrderDocument - All
ShippingMethod - All
Site - All
User - BackOfficeUser

Order Management 
Customer

CreditCard - All
CustomerClass - All
ItemQuantities - All
SalesDocument - Order Management Customer
ShippingMethod - All

Order Management 
Salesperson

CreditCard - All
Customer - All
CustomerClass - All
Item - All
ItemQuantities - All
SalesDocument - Order Management Salesperson
SalesOrderDocument - All
ShippingMethod - All
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Advanced MBF roles

Advanced MBF roles map Business Portal users to specific IDs in the back office, 
such as employee or salesperson IDs. This allows these users to access their 
personal data—for example, employee paystubs or salesperson commission 
information. The data permissions associated with each advanced role control 
access to the back office data that can be displayed in Business Portal.

The following table lists the advanced roles that are used with Order Management.

Role Data permissions

Customer This role is installed with Business Portal. For a list of data 
permissions associated with this advanced role, see the Business 
Portal Administrator’s Guide.

Salesperson This role is installed with Business Portal. For a list of data 
permissions associated with this advanced role, see the Business 
Portal Administrator’s Guide.
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troubleshooting 63

order type IDs, entering 24

P
prerequisites

Catalog Maintenance 12
eConnect 9

price levels
adding to price lists 27
assigning to customer records 28
creating 27

price lists, adding price levels to 27
pricing methods, selecting 55

Q
quantity available information, displaying 

53
quantity shortages

selecting an allocation method 23
specifying how they’re handled 54

R
Receivables Management

installing 12
integration 8
setting up 16

registration 13
reports, Item Price List 28
roles

assigning users to 51
Customer 51
Order Management Administrator 52
Order Management Customer 51
Order Management Salesperson 51
overview 51
Salesperson 51

S
Sales Order Processing

installing 12
integration 8
setting up 16

salespeople, specifying who they can 
enter orders for 58

sample data, for Catalog Maintenance 47
Secure Sockets Layer (SSL) 11
setup checklist 10
SharePoint groups

assigning users to 51
BP Order Management 

Administrator 52
BP Order Management Customer 51

SharePoint groups (continued)
BP Order Management Salesperson 

51
default permissions 67
overview 51

shipping options 57
site structure, overview 10
sites, overview 10
SQL tables, for Catalog Maintenance 47
support, contacting 4
symbols, used in manual 2

T
tables, for Catalog Maintenance 47
tax details, displaying 55
technical support, contacting 4
top-level Business Portal site, described 10
troubleshooting 63

U
units of measure, entering descriptions 19
URL

for customers to access Order 
Management 61

for salespeople to access Order 
Management 61

user accounts, for customers 51

V
View Details button 43
View List button 43

W
Windows accounts, for customers 51
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